
 

SESSION 1 
Forge a Shield 

In this session, students are lowly serfs who wish to become knights. When the 

King goes missing, they decide to rescue him from where he is being held 

captive. To begin this quest, they forge a shield for protection on their journey. 

When the noble lord sees their skills and dedication to the royal family, they are 

granted an apprenticeship to become a knight; first becoming a page. 

Assignment 1: About Medieval Times 

Assignment 2: Design a Shield 

Session 1 Review: Medieval Facts 

Session 1 Skill Review: Medieval Paper Dolls 

Session 1 Extension Activity: Design a Knight's Helmet 

 

  

Each TechnoKids project 
consists of 6 sessions, 
which are divided into 
separate assignments. An 
assignment is an activity 
that takes about 20 
minutes to complete. 
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Session 1: Forge a Shield 

Getting Started 

Overview 

In this session, students are lowly serfs who wish to become knights. When the King goes missing, 

they decide to rescue him from where he is being held captive. To begin this quest, they forge a 

shield for protection on their journey. When the noble lord sees their skills and dedication to the 

royal family, they are granted an apprenticeship to become a knight; first becoming a page. 
 

Materials 

 Microsoft Office Word  

 Microsoft Office Word Flashcards (Optional) 

o Drawing Tools Format Tab 

o Insert Tab 

o Quick Access Toolbar 

 Shield template 

 Shield sample file (Optional) 

 Session 1 Review: Medieval Facts (Optional) 

 Session 1 Skill Review: Medieval Paper Dolls (Optional) 

o Paper doll template 

 Session 1 Extension Activity: Design a Knight's Helmet (Optional) 

o Knight Helmet template 

o Knight Helmet 2 template 

 Workbook Files - Individual PDF Files for Assignments, Reviews, Skill Reviews, and Extension 

Activities (Optional) 

 

Teacher Preparation  

(Refer to the Preparing to Teach section of this guide for instructions) 

 Make the Quest folder available to students.  

 Determine a location for students to save their work during this project. 

 (Optional) Print the flashcards listed in the materials list for this session.  

 

 

Teaching Strategy 

In this project, students embark on a quest. Explain scenario to students. 

 

In this project, you assume the role of a lowly serf. You are called upon 

to help save the captured King. In his absence, the King's brother has 

taken over the throne. As you begin your quest, you see an opportunity 

for knighthood; if you can only rescue the King! 

  

For every session, the 
Teacher Guide features 
an Introduction with a 
materials list, preparation 
advice, teaching strategies, 
lesson plans for each 
assignment, and learning 
objectives for the session. 
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In this session, students design a shield. Explain scenario to students. 

 

In this session, the noble King has been captured and locked away. In 

his absence his brother has taken over the throne. As a lowly serf, you 

dream of becoming a knight. You begin your quest in the hope that by 

rescuing your ruler, you may be rewarded with knighthood. The journey 

is very dangerous. For this reason you make a shield for protection.  

 

Assignment 1 About Medieval Times 
 

In this assignment, introduce some key qualities and terms as a preliminary part of medieval 

times. If the class has already been researching or studying medieval life and has a good 

understanding of the time period, you can skip this assignment. 

 

Assignment 2 Design a Shield 
 

In this assignment, students design their own shield. They use Microsoft Office Word to add online 

pictures and apply a gradient fill to a template. Finally they print and attach a handle to make a  

3-dimensional shield. 
 

Before beginning, discuss the concept of coat of arms:  
 

In medieval times, knights would often bear a coat of arms on their shield or on a banner. 

The coat of arms was very meaningful because it contained symbols that told about the 

ancestry and qualities of a knight. For example, a lion could be used to symbolize 

courage, the bull could portray bravery, and the dove could be used depict peace. The 

practice of carrying personal shields with a coat of arms began during feudal times 

when it was necessary for a knight, with his face covered by the visor of his helmet, to be 

recognized at a distance.  
 

Students make their own coat of arms for their shield. It tells about their interests through the use 

of pictures. The coat of arms should show the following information: country, personal quality, 

area of interest, and something of their choice. Discuss the following: 
 

 Country: What symbol represents the country where students were born or live? For 

example, if students live in Canada they may choose a maple leaf. If they live in the 

United States they may wish to use an eagle. 

 Personal Quality: Are students brave, courageous, clever, honest, friendly, or kind? 

They must find an animal that represents a personal quality. For example, they may 

choose an owl to show intelligence or a dog to show loyalty. 

 Area of Interest: What do students do in their spare time? For example, do they play 

a sport, have a hobby, or an activity they are good at doing, such as painting, 

singing, or video games? Students must find a picture to show their area of interest. 

 Free Choice: Students select another picture to go on the shield that has symbolic 

meaning. 

 

HINTS & TIPS 

 If printing in black & white, use a gradient instead of a solid fill color. 

 Use simple pictures. They will stand out more on the shield. 

 Teacher supply stores carry themed classroom décor. Door covers, 

large posters, and wall trim can create a great medieval atmosphere. 

Take a photo of students holding their shields in front of a medieval 

background. You may want to have students make the helmet in 

Session 1 Extension Activity to complete the "look" of a knight. 

This section, for teachers, 
explains each assignment 
and gives helpful tips. 
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Lesson Plan 

Assignment 1 - About Medieval Times 

 Read to learn about medieval times. 

 Answer questions about the time period. 

 

 

Assignment 2 - Design a Shield 

 Open the Shield template. 

 If necessary, change the magnification to view the entire shield on the screen. 

 Insert an online picture to represent country, personal quality, area of interest, and 

another image that is personally meaningful. 

 Fill each section of the shield with a solid color or gradient. 

 Add student name to the header part of the document. 

 Save the document. 

 Print the shield. 

 Close Microsoft Office Word. 

 Assemble the shield by cutting it out and taping a paper strip on the back for a handle. 

 

  

The Lesson Plan lists the 
individual steps in each 
assignment. 
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Learning Objectives 

Below is a list of the learning objectives for this session. Students should be able to complete 

each task independently.  

 

Content Knowledge: 

 define concepts from medieval times including feudal system, serf, noble, fiefdom, 

class, knight, and coat of arms 

 

Technical Skills: 

 

Operating Environment 

 open and close a program 

 open a document 

 print a document 

 save a document 

 

Word Processing 

 adjust magnification 

 insert an online picture 

 select an object with the mouse 

 relocate and resize an object on the page 

 fill an area with color or a gradient 

 open and close a document header 

 add text to a document 

 

Applied Technology 

 produce a shield with symbols that represent the knight 

 

 

 

 

 

Learning Objectives are 
specified for each of the 
six sessions in the 
project. A checklist of all 
objectives is provided at 
the end of the project in 
Session 7. 

Sam
ple



TECHNOQUEST   SESSION 1 

 

TECHNOKIDS INC.  1-5 

Assignment 1: About Medieval Times 
 

About Medieval Times 

 
 

Understanding Classes 
 

During this time, people were divided into classes, such as serfs, nobles, or royalty. In this system, 

some classes were thought to be more important, or more worthy, than others. For example, a 

serf was very low in status, whereas a noble person had great importance. A noble could never 

become a serf because a person was born into a class. A serf was born into a peasant family, a 

king was born into a royal family, and a lord was born into a noble family. 

 

What is a Serf? 
 

Being a serf was a very lowly job. Serfs lived and worked on the land owned by the 

nobility. Although not a slave, everything they had belonged to the owner of the 

land. They had little freedom – they had to get permission from the landowner for 

whom they could marry, they had to pay if they wanted to become a monk, and 

they could not leave the village to go live elsewhere unless the landowner agreed. 

 

What is a Knight? 
 

A knight was a man in medieval Europe who served a King or other noble person, usually in 

return for a piece of land or for money. He swore to be brave, loyal, and courteous, and to 

protect the defenseless. His job was to fight in wars and to protect the serfs living on land owned 

by him or another noble. 

 

Becoming a Knight 
 

There were three stages to becoming a knight. At an early age, a boy would train to 

serve as a page, or attendant, in a knight's household. In his teens, the page 

graduated to the status of squire and received more responsibilities. As a squire, the 

boy tended his knight's horses, cared for his armor, trained with a sword and lance, 

and fought in battles around his master. To graduate to the status of a knight, a 

squire usually performed some heroic deed in battle. The squire was welcomed into 

the order of knights by being dubbed with a sword or slapped in the face by his 

Lord. Afterwards, the new knight would receive his fief, or gift of land. 

 

What is a Coat of Arms? 
 

In medieval times, knights would often wear a coat of arms on their shield or on a 

banner or flag. The coat of arms was very meaningful because it had symbols that 

told about the ancestry and qualities of a knight. For example, the symbol of a lion 

may be used to show courage, a bull to show bravery, and a dove to show peace. 

Knights needed a coat of arms so they could be recognized from a distance.  

Medieval times, or the Middle Ages, were a long time ago. It was a 

period in the history of Europe that lasted from about the year 350 to 

1450. In medieval times, a feudal system was used as a means of 

government. It was a form of rule in which fiefs, or pieces of land, 

were given to people of nobility such as the King, Lords, and Knights. 

Peasants were called serfs. They lived and worked on the land as 

servants. Instead of being paid money, they received a place to live, 

some of the food that they grew, and protection by the landowner. 

Introductory information 
can be used for 
classroom discussions 
prior to using computers. 
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Questions About Medieval Times 

1. What is a fief? 

 A fief is a piece of land. 
 
 

2. Who was part of the noble class? 

 Nobility were Kings, Lords, and Knights. 
 
 

3. What is another name for a peasant? 

 Another name for a peasant is a serf. 
 
 

4. Who was thought to be more important, a noble or a serf? 

 A noble was thought to be more important than a serf. 
 
 

5. Could a noble ever become a serf? 

 No. A noble was born into a family of nobles. 
 
 

6. What was the job of the serf? 

 The serf had to work on land owned by the noble. 
 
 

7. What was the job of the knight? 

 The knight fought in wars and protected the serfs. 
 
 

8. What were the three stages of becoming a knight? 

 The stages were: page, squire, and knight. 
 

 

9. What gift did a person get when they became a knight? 

 A knight was given a fief, or piece of land. 
 

 

10. What is a coat of arms? 

 A coat of arms is a shield or banner with symbols that told about the ancestry or  

 qualities of the knight. 
 

For paperless classrooms; 
students can answer the 
questions in their digital 
workbooks using the 
latest version of Adobe 
Reader. The Teacher 
Guide includes answers. 
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Assignment 2: Design a Shield 
 

 

Your shield should contain symbols that tell about you. You will use online pictures as symbols. 

Your shield will include: 

 

 Country: Select a symbol that represents your country. Use objects such as an animal, 

plant, or flag. For example, if you live in Canada you may choose a maple leaf (emblem 

on the flag), whereas for the United States you may wish to use an eagle (national 

animal). 

 Personal Quality: Are you brave, courageous, clever, honest, friendly, or kind? Find an 

animal that represents those qualities. For example, you may choose an owl to show 

intelligence, or a dog to show loyalty. 

 Area of Interest: Think about something you like doing. For example, do you play a sport, 

have a hobby, or an activity that you are good at doing, such as painting, singing, or 

video games? Find a picture to show your area of interest. 

 Free Choice: Select another picture to go on the shield. Remember it must tell something 

about YOU! 

 

 

  

The noble King has been captured and locked away. You begin your 

quest in hopes that by rescuing your ruler, you may be rewarded with 

knighthood. The journey is very dangerous. For this reason you make a 

shield for protection. 

Personal Quality:  

Dog for loyalty 

Country:  

Maple leaf to represent 

Canada 

Free Choice:  

Books to show interest in 

reading 

Area of Interest:  

Computer to show 

technical knowledge 

Critical thinking skills are 
developed as students 
choose pictures for their 
shield. 
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Open Shield Template 

 Open the Quest folder. 

 Double click on Shield to open the document. 

 
 

 

Get a Closer Look (Optional) 

 

 Look for the Zoom slider, at the bottom of the window.  

 Adjust the magnification to view the entire shield on the screen. To zoom in, drag the 

slider to the right. To zoom out, drag the slider to the left. 

 
 

 

Insert an Online Picture 

 

 

 Click the Insert tab, find the Illustrations group, and choose Online Pictures. 

  

The document should open to display the entire page.  

If not, follow the instructions below to adjust the zoom level of the document. 

Use online pictures to decorate the shield. Select pictures that are symbolic. 
 

 Country - symbol to show country or birthplace  

 Personal Quality – symbol to show quality, such as loyal or brave 

 Area of Interest – symbol to show hobby, sport, or other interest 

 Free Choice – symbol that is personally meaningful 

In this activity, students 
use the provided template 
to make their shield. 
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circular handle 

to turn 

 In the Bing Image Search box, type in a search term, and then click Search. 

 
 

 Scroll through the results. 

 Click on the picture you like and click Insert. 

 Click Layout Options and choose In Front of Text. 

 
 

 Click in the center of the picture. Drag the picture to place it in a section of the shield. 

 Resize the picture, by resting the mouse over a corner sizing handle. Click and drag 

inwards to make the picture smaller. Click and drag outwards to make the picture larger. 

 

 

 Rotate the picture by resting the mouse over the circular handle. Click and drag the 

mouse in a circular direction to rotate the picture. 

 

 Continue to add online pictures to complete the shield. 

  

Search 

In Front of Text 

TIP: Need to undo an action? Click 

Undo on the Quick Access toolbar. 

Want to put it back? Click Redo. 

Undo Redo 

Try these search terms: 

 country name flag 

 country map 

 national symbol 

 national animal 

 national tree, 

flower, or 

plant 

 

Tools are enlarged to 
make them easy to find. 
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Fill the Shield with Color 

 Double click the mouse on a border of a section of the shield.  

 Look for the small handles to indicate the selection. 

 

 Find the Shape Styles group on the Drawing Tools Format tab.  

 

 Click Shape Fill. 

 Choose a solid color from the palette.. 

 

 To select a gradient in that color palette, click Shape Fill again and select Gradient. 

Choose an option from the gallery. 

 

 Repeat for the remaining three sections of the shield. 

  

Check to make sure that 

the section of the shield is 

selected, not the whole 

shield or the picture. 

If you are not printing in 

color, you may want to 

omit this step. 

Step-by-step instructions 
make it easy to use 
Microsoft Word. 
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Add Student Name to the Header  

 

 Position the mouse at the top of the page. Double click in this area to open the header. 

 

 Type Student Name. 

 

 Press ESC on the keyboard to exit the header section. 

 

 

Save the Document 

 Find the Quick Access Toolbar in the upper left corner of the document. 

 

 Click Save. 

 Go to your student folder and click Save.  

  

BEFORE you print the shield, it must include your name. 

Place your name in the header of the document. The 

header becomes the handle for the shield when 

printed.  

[Type here] 

Chris 

Resource files are digital, 
customizable files 
provided with the project. 
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Print the Shield 

 From the File tab, select Print.  

 Click the Print button. 

 Click the File tab and choose Close. 

 

Assemble the Shield 

 When the document prints, cut out the shield along the edges. This should leave a strip of 

paper from the top of the sheet (the piece with the student’s name). Take this strip, and 

fold the edges inwards along the dotted vertical lines.  

 

STRIP OF PAPER ALONG THE TOP OF THE SHEET 

 

FOLD INWARDS ALONG THE DOTTED LINES TO CREATE THE SHIELD HANDLE 

 Place the strip of paper on the back of the shield, with the tabs folded inwards. Tape 

them down to create a handle that students can use to hold the shield. 

 

 

 

 

CONGRATULATIONS! 

You are a page. 

 

In his position of temporary ruler, the King's brother has taken notice 

of your armor making skills and decided you are worthy enough  

to begin your apprenticeship as a knight.  

 

You are now a page. 

After each task students 
advance in their quest to 
find the King and become 
a knight. Sam
ple
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Session 1 Review: Medieval Facts 
 

 

 

1. The feudal system gave land to nobles and had serfs work on the land 

in return for protection and a place to live. 

True False 

 

 

2. A noble was less important than a serf. True False 

 

 

3. A serf was paid money for their work. True False 

 

 

4. A King was born into a royal family. True False 

 

 

5. A serf had to get permission before they could marry. True False 

 

 

6. A knight's job was to farm. True False 

 

 

7. A boy could become a squire when he was a teenager. True False 

 

 

8. A squire learned how to fight with a sword. True False 

 

 

9. A person was given a horse when he became a knight. True False 

 

 

10. A coat of arms uses symbols to tell about a family and its heritage. True False 

 

  

Circle either true or false for the 

statements below. 

Review lessons at the end 
of sessions provides 
activities to check and 
reinforce newly learned 
skills, concepts and 
terminology. 
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Session 1 Skill Review: Medieval Paper Dolls 
 

 

 

Open the Paper Doll Template 

 

1.  Go to the Quest folder and double click the paper doll document. 

  

2.  Double click on a shape to select it and activate the Drawing Tools Format tab. 

  

 

 

 

Fill the Shapes with Color 

 

3.  Use the commands in the Shape Styles group to color the pieces. 

 
 Use Shape Fill to fill with a solid color, apply a gradient, texture, or pattern. 

 Use Shape Outline to adjust the color, width, and style of the outline. 

 

 
  

4.  If the shape has more than one area, such as the boy's tunic, click a second time to 

select just the area you wish to color. 

  

 

  

Use your drawing skills on the computer to color 

the clothing of the doll and add online picture to 

decorate the costume. Then print the pages, cut 

out the pieces, and put the doll together! 

First click selects 

the entire tunic. 

Second click 

selects the collar. 

Learn more about how 
people dressed during 
medieval times with this 
skill review activity. 
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Add Online Pictures 

 

5.  Click the Insert tab and choose Online Pictures to open the Search box.  

Add pictures to the boy's tunic, the girl's hat, and the dress.  
  

6. 7

. 

Adjust the layout of the picture to In Front of Text. 
 

  

7.  Resize the picture to fit the clothing. 

 

 

 

Print the Paper Doll and Clothing 

 

8.  Save your work in your student folder. 

  

9.  Print the doll, hair, and clothing using a color printer. If you have access to a color 

photocopier, you may wish to photocopy the printed pages on to card stock and 

enlarge them to create bigger dolls and clothing, which are easier to cut out. 

  

 

 

 

Cut Out the Shapes and Dress the Doll 

 

10.  Option 1: Changeable Dolls 

Cut out the body, hair, and all clothing, being careful to cut around the tabs. Bend 

the tabs to hold the clothing on the doll. Now you can change the hair and clothing 

of the doll. 

  

 Option 2: Permanent Costumes 

Cut out the body and only the hair and clothing for the boy or the girl cutting off the 

tabs. Glue the hair and desired clothing on to the paper doll. If you want to have both 

a girl and a boy doll, print a second copy of the body of the doll. 
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Session 1 Extension Activity: Design a Knight's Helmet 
 

 

Select a Helmet 

 Open the Quest folder. 

 Double click on either Knight Helmet or Knight Helmet 2 to open.  

 

or 

 

KNIGHT HELMET  KNIGHT HELMET 2 

 

Get a Closer Look 

 Adjust the magnification to view the entire helmet on the screen. 

 

 

 

Fill a Shape with a Fill Effect 

 

 Double click on a shape to select it and activate the Drawing Tools Format tab. 

 Find the Shape Styles group. Click Shape Fill. 

 Pick a color from the palette. The shape is filled with a solid color.  

 With the section still selected, click Shape Fill again and choose Gradient. 

 Click on a variation to apply it to the current color selected. 

 Continue to fill each shape to create a unique helmet. 

Knights wore armor to protect them while in battle. 

Follow the instructions to create a medieval helmet. 

Decorate the helmet by filling shapes with a fill effect. 

If you have time, explore the texture options. 

If the preview of 

each file does not 

show when opening 

the Knight folder, 

select a file and 

click Show the 

preview pane.  
 

You might also see 

a preview at the 

bottom of the 

window when the 

file is selected. 

Extension activities at the 
end of sessions provide 
optional enrichment 
challenges. 
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Add Student Name using WordArt 

 

 Click the Insert tab, find the Text group, and click WordArt. 

 Choose a style from the WordArt Gallery options. 

 

 Replace “Your text here” with Student Name. 

 

 Move the object to the desired position on the helmet by dragging its border. 

 
 

 

Save and Print the Document – Exit Microsoft Word 

 Click Save on the Quick Access Toolbar. 

 Go to the desired location. Click Save. 

 From the File tab, select Print. Click the Print button.  Close Word. 

 

Add your name using WordArt. WordArt adds text to a 

document using curved or slanted shapes, shading, 

color, and 3-dimensional effects. 

The circular handle rotates the 

WordArt. 

Handles on the sides change 

the width or height. 

The pink handle changes the 

shape or orientation.  It may 

appear with some text effects. 

When the document prints, the helmet can be cut out along the 

edges. Cut away the section that reads Cut out this Section. Staple 

string to each side of the helmet. Use the string to secure the helmet 

around the student's head. 
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